PowerLog Client v4 Software Update Information

You can get the latest software updates as well as Technical Support by visiting the P Squared Website at http://www.psquared.net/support/ or the P Squared Forum at http://forum.psquared.net/

v4.0.38

Added support for Windows 7

v4.0.37

You can now access the Powerlog Monitor from the Tools Menu.

The file locations for the Directory Manager and the Monitor have changed.

If you do not have a location for the P Squared Contacts and Users Directory already set on the computer, the default is now C:\Documents and Settings\All Users\Application Data\P Squared\Directory\Profile1 as this is more suitable for Vista users.

(PSQReference: SVN)

v4.0.36

Windows Vista Support: This version has been designed to also run on Windows Vista, but testing is still being carried out. For more information about Vista Compatibilty please visit http://support.psquared.net/softsupport.htm

v4.0.34

No Changes - Rebuilt to match Capture

v4.0.32

No Changes - Rebuilt to match Capture

v4.0.31

You can now log in and out of client without closing it down using the Logout option on the File menu.

The following issues have been fixed:
·	Seeking on the time track while playing a compilation would re-enable the main play button when it shouldn't.


v4.0.29

Now perform Daylight Saving Time adjustment for any local time zone.

The following issues have been fixed:
·	Spring forward Daylight Saving hour played the hour before instead of nothing.
·	When playing over midnight, the displayed date did not change.
·	Hardware mark graphical display was not updating correctly since v4.0.27

v4.0.28

The following issues have been fixed:
·	Installer registration issue prevented the PowerLog Directory Manager from running.

v4.0.27

The following issues have been fixed:
·	Standardised many of the terms used to refer to different types of marks.
·	Compilation to many files in a folder incorrectly prevented the compilation if the whole compilation was longer than the file system would allow.  It now uses the length of the largest segment.  Compilation to a single remains as it was before.

v4.0.26

The following issues have been fixed:
·	Some logs would not load any day other than the 31st December 1899.
·	Serial marks context menu was not displaying correctly.
·	Serial marks view type (all or view) was using the DLS setting not the serial one.
·	When changing date across a logging period (eg: production to standard) but not changing the time, the format information panel did not update.
·	Cursor remained on hourglass after next or previous day buttons were clicked.
·	Wording change to the "log is already open" messagebox.
·	Poor audio quality when converting between non-divisible sample rates (eg: 44.1k and 48k)
·	Mouse pointer remained as an hourglass when changing day

v4.0.25

The following issues have been fixed:
·	The "Add Gaps to Compilation" option for silence marks was broken from v4.0.17 onwards.
·	The Customise PowerLog tab strip was too short for the content and clipped it.
·	Some minor caption changes to menu items.
·	Played the wrong files during the BST-GMT cross over in October.

v4.0.24

The mark auto-updater was enabled as soon as marks were loaded (either automatically or manually).  This is behaviour is now optional and can be turned off in the Program Settings window.  When auto-updating is disabled the marks lists can be updated manually using a new item in the View > Marks menu.

v4.0.23

There is now an option in Program Settings to allow you to turn off automatic Mark Loading when a new log or day is loaded.  This allows faster navigation on systems that have a very large number of marks.  In this mode the marks can be loaded manually by clicking on the marks panel.

The following issues have been fixed:
·	The compilation panel was auto-updating marks when is shouldn't.
·	The mark auto-updater was firing when not looking at the current day.

v4.0.22

Previously when you double clicked on a mark it would switch the lists view to show the list for the type of mark you clicked on.  This has been removed since most users would it counter productive.

The following issues have been fixed:
·	If playback got to the end of the log then you would have to scroll back one segment before the play button would be enabled again.

v4.0.21

Added the "Display All Marks" and "Display Marks in Current View" for Serial messages.

Panels that are unavailble (such as Logic and Silence Marks in Lite Mode) now present you with information to help you upgrade.

The following issues have been fixed:
·	Realtime updates to the Serial messages list caused it to duplicate the marks loaded so far in current hour.
·	You could enter compact mode while the compilation playback was active. This resulted in audio playing with no apparent source.  You now can not enter compact mode while the compilation is playing out.
·	Starting playback on the compilation panel did not stop main playback resulting in the two output streams overlapping each other.
·	License expiry warning showed incorrect number of days until expiry.
·	Some of the buttons flickered when the mouse passed over them.

v4.0.19

There is a new button on the compilation panel that merges segments that are back-to-back.  This often happens when a mark cross the top of the hour.  Eg: 2 marks (12:57:00 - 13:00:00 and 13:00:00 - 13:03:00) would be removed from the list and replaced with 1 mark (12:57:00 - 13:03:00).

The following issues have been fixed:
·	Several problems with tracking mode including the menu option not un-ticking and still being able to manually scrub.
·	The menu items that launch external tools were still available even if the tool they launched wasn't.
·	There wasn't a warning when editing the currently logged in user that the changes would not take effect until the software is restarted.
·	The compilation progress bar did not advance properly when the source audio files were certain wav formats.
·	when changing sound card settings the compilation playback would not update until restart.
·	On the Select Recurrent Segments window the "custom" entry in the time "end after" combo box was still visible when in "end after" mode.  It should not have been and is only there for when you are in "End At" mode and have selected a time that does not match one of the standard durations.
·	On the first change of log the tick on the select log menu would remain on the original log as well as appear on the new one.
·	When using IMA ADPCM files you could not seek to anything other than segment boundaries.
·	After changing days the mouse pointer did not always return to the standard arrow but remained on the hourglass.
·	When generating segments on a log that has logic lines with no marks associated with them the segment list was wrong.

v4.0.18

The following issues have been fixed:
·	Using a soundcard samplerate that was less than the audio file's samplerate caused and crash to desktop.
·	The last open log was not be stored correctly and so client was opening the first one in the directory regardless on startup.
·	In some circumstances you when loading a log with old WMA audio files (ie the logs settings have been changed) then you could receive a "busy" error.  This can also be seen as a crash to desktop.

v4.0.17

New "bigger" front end.

Clearer tooltips.

The following issues have been fixed:
·	Changing soundcard samplerate during playback of WMA files caused slow/fast playback and eventually a crash to desktop.
·	The Generate Compilaton Segments window would give you a segment in the current day that had not actually been recorded yet.
·	The WMA format displayed in the Log Summary panel was inaccurate.
·	Compiling in the "many file in a folder" mode would not write any audio if the source audio format had a lower bitrate than the destination.
·	On startup the menu item for the current output format was not ticked.
·	Silence marks were sometimes hidden incorrectly.

v4.0.9

The following issues have been fixed:
·	There is now second level accuracy on the 'jump to time' window.

v4.0.7

Log Summary panel on the bottom tab.  Currently include Log name and path, Production, Standard and Archive periods plus the available log range.

Added P Squared Directory log files to support files.

The following issues have been fixed:
·	Trying to open the third log in a directory would open the customise window instead.
·	There was a checkmark on the first log's menu item if the client loaded a different log at startup.  This check would not disappear until the first log was selected via the menu.
·	Leaving Cooledit pk files in the log folders caused the client to exit when you seeked to that segment.
·	Clipping occurred when playing very quiet audio.
·	would exit to desktop if the soundcard could not be set to the requested samplerate 

v4.0.6

Log Summary panel on the bottom tab.  Currently include Log name and path, Production, Standard and Archive periods plus the available log range.

The following issues have been fixed:
·	Large silence marks did not display in the list
·	When you clicked on the picture of a silence mark that was not in the list then the client would exit.
·	Time scale marks weren't quite right causing duplicate ticks on the hour and ten minutes marks
·	Compiled audio segments were slightly out.
·	Compilation playback could sometimes get be playing one segment and be highlighting another.
·	Large pre-load when playing back audio in the compilation panel
·	When using the quick mark feature to write an audio file there would be occaisional skips in the audio.
·	tweaked the warning message boxes to do with compiling large files to make it more obvious that the compilation will take a long time.
·	tidyed up jump to and from the extreme ranges of the log.
·	graphical corruption when you double click the date panel with the drop down date chooser visible.

v4.0.4b
Please note that this is a Beta version and as such may contain bugs, perhaps of a critical nature.  You should not use this software on any machine that is mission critical.  P Squared Ltd. is not liable for any loss or damage how so ever caused, either directly or indirectly through the use of this software.

You must be using a v4.0.4 or higher Capture machine with this version Client.

Changed the limit marks view option to only update the marks list when you finish scrolling.

Added a format information button to allow you to see the current file format.

Volume slider is now larger and hence easier to manipulate.

Compilation file handling changed to a stateless model.

Numerous bug fixes.

v4.0.2b
Please note that this is a Beta version and as such may contain bugs, perhaps of a critical nature.  You should not use this software on any machine that is mission critical.  P Squared Ltd. is not liable for any loss or damage how so ever caused, either directly or indirectly through the use of this software.

You must be using a v4.0.2 or higher Capture machine with this version Client.

Switched the marks type selector from a tab strip to a combo.  This is to support:

Serial message logging.  At present there are three defined 'message levels':  'Basic' , 'Advanced' and 'Engineer'.  Each level presents more information about the serial messages than the last.  You can specify which level messages you wish to view when using PowerLog Client.  Additionally, using the P Squared Directory system you can restrict the types of messages that your users can choose to view.

Re-instated the automatic segment generation feature of the compilation tray.

PowerLog now has a customised set of WMA profiles.  These are stored in the pspl4.prx file in the installation folder.  This means that you can create your own profiles using the WM Profile Editor.  Please note the PowerLog stores the index of the profile and so if you insert new profiles into the middle of the file you could change user's compilation formats unexpectedly. Adding new profiles to the end of the file is completely safe.  This change can be made without restarting PowerLog, however any open format chooser windows will not include them.  Simply close the chooser and re-open it.
Another important note about editing this file is that if you use a centralised user directory and do not copy the new prx file out to all of clients then your users will varying results when they try to write compilations.

The following issues have been fixed:
·	Support File generator not including all settings files
·	Calendar would lay under the bottom pullout tray
·	Visualisations causing slow down even when not visible
·	When focused on the month view of the date/time chooser window you would need to click twice on the ok button to exit.  This is a Microsoft bug.  The work around is to have initial focus on the time editor.  You now only need to click twice if you have actually used the month chooser.
·	When switching logs the marks list would be cleared AFTER they'd been filled.  This would cause drag and context menu operations to fail.
·	Slight graphic glitch when switching from a log that does not have DLS logging to one that does.
·	Current log is now ticked in the logs menu
·	memory leak when loading and unloading logs.
·	run-time error when double clicking on the DLS ticker.
·	marks would not be loaded when selecting a new log in certain circumstances.
·	the drop-down date chooser would not change away from the current date.   This did not affect the previous/next day buttons or double clicking on the clock.
·	tightened up the visualisations.
·	overflow on some particularly loud audio samples.
·	exit to desktop when scrubbing fast backward past 00:00.
·	invisible status labels on splash screen when used on XP with the silver style.
·	there was a slight crackle on ADPCM compilation files
·	the compilation progress bar was always accurate
·	"No Data Written" error when running a compilation after switching logs.
·	files would be written with MS ADPCM instead of IMA.
·	crash when dragging a file from explorer over the compilation tray
·	overflow error when playing silent logs
·	crash when playing a compilation list after doing a compile operation
·	some incorrect button colours
·	when the drop down calendar didn't actually change the day there was no message explaining why.
·	the segment generator button would remain active during compilation operations
·	setting user formats to nothing would not stick.  They reverted to CD quality audio.  This produced folder icons on buttons that should have been invisible.
·	deleting a compilation item would sometimes not remove it from the list.  This would cause a crash when you tried to play the list.

v4.0.1b
Please note that this is a Beta version and as such may contain bugs, perhaps of a critical nature.  You should not use this software on any machine that is mission critical.  P Squared Ltd. is not liable for any loss or damage how so ever caused, either directly or indirectly through the use of this software.

Can now cope with multiple outputs per logs.  

A wide range of different audio types are supported including WMA, MP2 and Ogg Vorbis.

Completely new human readable file structure making manual backups and fault diagnosis easier.

New Media Player style front end.

Now has graphical audio display with 4 different modes including Spectral and Frequency Analysis

New easier way to select the exact time you need to listen to.

P Squared User Directory integration to allow easy management of users and the ability to restrict what they can and can't do.  This also allows users' configuration preferences to migrate with them across workstations even without a Windows domain.

Compilation and mark writing has been restored.  This now has an easier way to select the audio format and of course the ability to use all the supported audio types.

The User Directory also allows you to control which options are available to the user.  For example, you could restrict them to one particular PowerLog Directory or Log or you could restrict which format and quality them can use to extract logs.

New Compilation mode that writes each cut to a separate file in a specified folder.


v4.0.0a
Please note that this is an Alpha version and as such is almost guaranteed to contain bugs, perhaps of a critical nature.  You should not use this software on any machine that is mission critical.  P Squared Ltd. is not liable for any loss or damage how so ever caused, either directly or indirectly through the use of this software.

This version is designed for use only with v4.0.0 servers.  It will not read earlier logs and since the file structure is about to change it will not work with future versions either.

Other than the change to WMA format (ability to read multiple file formats will come later) the only difference between this version and previous ones is that compilation and segment generation is disabled.  This will be restored later.

